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Interface Builder
This document describes the interim release of Interface Builder. Interface
Builder can be used to create cross-platform dialog box interfaces for plugins.

This version of Interface Builder is based on an internal tool used by the
development group at Electric Image, and is provided “as is.” This version
lacks many features that would be present in a supported product, such as
clipboard support and undo. We will be addressing these deficiencies in an
upcoming release, but until then we wanted to give out something that could
be used by the plugin development community as soon as possible.

This version of Interface Builder runs only on the Macintosh, and assumes
familiarity with Macintosh terminology, such as “resource file.”

Overview

This section gives a quick outline of the steps you will take to build a dialog
box resource using Interface Builder.

Step 1: Link A Resource File

You must first tell Interface Builder what resource file into which you will be
saving your dialog box resource. This is called linking a resource file. You
can only link existing resource files, so you will need to create a resource file
using ResEdit or Resorcerer.

When you first start Interface Builder it presents a file dialog box. It is asking
you for a resource file to link. Also, you can choose the “Link Resource”
command from the “File” menu. This will bring up the standard file dialog
box which will allow you to pick a resource file to link.

Step 2: Create Controls

Next, use the creation and manipulation tools to add controls to the edit
window. During this step, you will use the property dialog boxes to assign IDs
to the controls you will need to manipulate at run time.

N O T E : The ID names you enter in the property dialog boxes must be
legal C identifiers. Interface Builder will not warn you if you
do not create legal identifiers.
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Step 3: Write Control IDs

Once you have assigned IDs to all of the controls you will need to manipulate
at run time, choose the “Write Control IDs” command from the “Utility”
menu. This will write a file called “Output.c” in the same directory with
Interface Builder. This file will contain an enumeration definition with all of
your control IDs. You can open this file, copy the enumeration and paste it
into your code.

N O T E : If you edit the dialog box further, you will need to regenerate
the IDs by choosing the “Recompute IDs” command from the
“Utility” menu, followed by the “Write Control IDs”
command.

At various times, Interface Builder may generate new IDs for your controls.
Therefore, the IDs contained in your dialog box resource may get out of sync
with the IDs listed in the “Output.c” file. To avoid this situation, always
manually regenerate your control IDs when you are done editing.

When generating IDs with the “Write Control IDs” command, make sure that
the file “Output.c” is not open in another application (like CodeWarrior);
otherwise the “Write Control IDs” command will fail, but you will not be
notified of the failure.

Step 4: Save Your Dialog Box Resource

Choose the “Save” command from the “File” menu. This will bring up a
dialog box which asks you to assign a resource ID for your dialog box, as well
as a resource name. If you type in the resource ID of an existing resource, you
will be prompted to confirm that you really want to save to the given ID.

Step 5: Editing Existing Dialog Boxes

To edit your dialog box interface at a later date, first link the resource file
containing your dialog box as described in Step 1. Then choose the “Open”
command from the “File” menu. This will present a dialog box with a popup
menu listing all of the dialog box resources in the linked resource file. Choose
the one you want and press the OK button. Your dialog box resource will be
opened in a new edit window, which you may edit and save as described
above.
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Reference

Windows

There are two main types of window in Interface Builder: the tool window
and an interface edit window.

The Tool Window

The tools in the tool window are grouped into three tabs: Manipulation,
Alignment, and Controls.

The first tool in the Manipulation tab (the one that looks like an arrow) is the
Test tool. When this tool is active, the user interface behaves as it would at
run time. That is, buttons press, scrollers scroll, and text can be entered into
edit text boxes.

The other tool in the Manipulation tab is the Edit tool. When the edit tool is
active, clicking in the edit window edits the objects clicked upon. Using the
edit tool you can resize objects, move them and double-click on them to bring
up property dialog boxes.

The Alignment tab contains tool buttons that perform alignment operations.
The buttons are (listed left to right and top to bottom): Align left, Align right,
Align top, Align bottom, Align horizontal, Align vertical, Center horizontal,
and Center Vertical.

Each of the tools in the Controls tab are control creation tools. When a control
creation tool is active, clicking and dragging in the edit window creates the
corresponding user interface control. The tools in the Controls tab, from left to
right and top to bottom, are:

• Group Box

• Tab Group

• OK Button

• Cancel Button

• Picture Button

• Text Button

• Edit Text

• Check Box

• Divider



Interface Builder Interim Release 1/31/2001

4

• Scroller

• Static Text

• Picture

• Color Button

• Radio Button Group

• Shader Icon

• Color Slider

• Popup Menu

• List Box

N O T E : Do not use the Shader Icon control. It is unsupported.

The Edit Window

The Edit window is the window in which you create and edit your dialog box
resources. You can open more than one Edit window at a time; choosing
“New” from the “File” menu creates a new Edit window.

Controls

Each control has a set of properties that are editable in Interface Builder. To
edit the properties of a control, double-click the control using the Edit tool to
bring up its property dialog box. Each control has a different property dialog
box, but they all have two properties in common.

Rectangle Given as six edit fields (left, top, right, bottom,
width, height), the rectangle property is the
boundary rectangle of the control

ID This is the enumeration ID that will be used for
the control when you write out the control IDs.

The controls you can create, and the properties you can edit, are described
here. In the discussion below, only the properties unique to each control are
described; since each property dialog box contains the Rectangle and ID
properties, they are not redundantly described for each control type.

Note that there are “extra” properties displayed in the property dialog boxes
that are not described here. These properties should be considered reserved;
you should not attempt to edit them, as they will result in undefined behavior.
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Group Box

The Group Box control draws a box, with an optional label. The Group Box’s
editable properties are

Group Settings The label of the group box. If this field is empty,
the group box does not draw a label.

Type A radio button group which allows you to select
the different styles in which the group may
appear. This radio button group is one of two
unlabeled radio button groups in the Group Box
property dialog box; it is the left radio group.

Label Position A radio button group which allows you to select
the location at which the label will be drawn.

Note that one of the choices in the Type radio button group is “Invisible.” If
you make an invisible group, then this control will really be a user control at
run time.

Tab Group

The Tab Group draws a group of tab panes. The Tab Group’s editable
properties are

Horizontal Tabs A check box which, if set, draws the tabs
horizontally across the top of the group. If the
check box is clear, the tabs are drawn down the
left side of the control.

Tab Total A number between one and nine, which will be
the number of tabs in the tab group.

Tab Titles A series of nine edit fields, labeled “1” through
“9”. Editing these fields will change the titles of
the corresponding tabs.

Note that if you create a control within a tab group, or drag an existing control
into a tab group, the tab control’s current tab will assume ownership of the
control. To switch tabs, click on the Test tool and then click on another tab.

OK Button

The OK Button is a push button that causes the dialog box it is in to be
accepted. The OK Button’s editable properties are

Name The title displayed within the OK Button.
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Icon The resource ID of the image displayed next to
the title. An ID of zero removes the image from
the button. The ID may be the ID of an ‘argb’
resource, a ‘cicn’ resource or a ‘PICT’ resource.

Border Controls the “thickness” of the border of the OK
Button.

Icon Position Controls the placement of the OK Button’s icon
in relation to the title string.

Contents Controls the location of the title string within
the OK Button.

You should not need to change any of the default values.

Cancel Button

The Cancel Button is a push button that causes the dialog box it is in to be
dismissed and rejected. The Cancel Button’s editable properties are identical
to the OK Button’s editable properties.

Like the OK Button, you should not need to change any of the default values.

Picture Button

The Picture Button is a push button that displays an icon inside. Its editable
properties are identical to the OK Button’s editable properties. However, you
may change the properties any way you like.

Note that when you bring up the property dialog box of the Picture Button, it
initially has no title. It is possible to give the Picture Button a title, and it is
possible to give a Text Button an icon. In fact, there is no difference between
a Picture Button and a Text Button except for the default values of their
properties.

Text Button

The Text Button is a push button that displays a title string. As discussed
under Picture Button above, the Text Button is actually identical to the Picture
Button.

Edit Text

The Edit Text control’s editable properties are
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Name The label displayed to the left of the edit text
field.

Use Filter A check box that controls whether filtering is on
by default

Filter Type A radio button group that allows you to select
what kind of filtering to set for this Edit Text
control.

N O T E : There are two fields of the Edit Text dialog, labeled Show
Controls and Delta, which are obsolete and are ignored.

Check Box

The Check Box’s editable properties are

Name The title of the check box.

Divider

The Divider is a control use strictly for visual separation. It has no editable
properties, and no property dialog box.

Scroller

The Scroller control displays a scroll bar with a thumb which the user can
drag up and down (for horizontal scrollers) or right and left (for vertical
scrollers). Whether a Scroller is horizontal or vertical is controlled by whether
the width or height is the larger extent.

The only properties editable in the Scroller’s property dialog box are the
Rectangle and ID properties. Note that you cannot set the default value or
maximum of the Scroller; these values must be set at run time using the User
Interface API.

Static Text

The Static Text control’s editable properties are

Name The text displayed in the static text control.

Picture

The Picture control’s editable properties are
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ResID The resource ID of the image displayed in the
Picture control. This ID may be the ID of an
existing ‘argb’, ‘cicn’ or ‘PICT’. The image
resource must already be present in the currently
linked resource file; there is no way to add an
image resource to your linked resource file from
within Interface Builder.

Color Button

The Color Button allows a user to choose a new color using a color picker.
The Color Button’s editable properties are

Edit Alpha A check box that, if set, will allow the user to
edit the alpha value of the color when the color
picker is presented.

Prompt An edit field that contains the prompt string
displayed in the color picker when the user
clicks the Color Button.

Radio Button Group

The Radio Button Group’s editable properties are

Button Total A number between one and nine, which will be
the number of radio buttons in the Radio Button
Group.

Button Titles A series of nine edit fields, labeled “1” through
“9”. Editing these fields will change the titles of
the corresponding radio buttons.

Note that the button titles are the left-most column of edit fields in the Radio
Button Group property dialog box. Do not edit the right-most column of edit
fields. These fields should always be set to 0.

Color Slider

The Color Slider’s editable properties are

Slider Type A radio button group that selects the appearance
of the Color Slider. Each type value causes the
Color Slider to display a different kind of color
ramp.
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As with the Scroller control, you cannot set the default value or maximum of
the Color Slider; these values must be set at run time using the User Interface
API.

Popup Menu

The Popup Menu’s editable properties are

Item Total A number between one and twenty. This will be
the number of items displayed in the popup
menu.

Item Names A series of edit fields, labeled “1” through “20”.
Editing these fields will change the
corresponding items in the Popup Menu.

Notify On Every Click A check box that, if set, will cause your hit
function to be called every time the Popup
Menu is clicked, even if the user does not make
a new choice. If this check box is off, your hit
function will be called only when the user
selects a new item in the Popup Menu.

Name The title of the Popup Menu.

List Box

The List Box has no editable properties beyond the Rectangle and ID
properties. You must populate the List Box with items at run time. Also, note
that when displayed in Interface Builder the List Box contains a series of
strings and icons. These items will not be present in your List Box at run time.

Tab Order

The tab order is the order in which key focus controls will be visited when the
user presses the tab key. To set the tab order, choose the “Set Tab Order”
command from the “Utility” menu, then click on the Edit Text controls in
your window one by one, in the order you want. As you click on each one,
Interface Builder writes the order number on the edit text, until you get to the
last Edit Text control, at which point the tab order has been set and the display
reverts back to normal.

This command places Interface Builder into a mode where it will not respond
until you have clicked on each Edit Text control.

N O T E : There is a known bug in Interface Builder which prevents the
Set Tab Order command from working correctly when there
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are Edit Text controls in tab group controls. There is no way to
switch tabs in a tab group control when you are in the set tab
order mode, so if you have Edit Text controls inside different
tabs you will not be able to click on all of the Edit Text
controls. The workaround is to temporarily move the Edit Text
controls out of the tab group, use the Set Tab Order command,
and then put them back into the tab group control.

Miscellaneous

The Edit menu contains commands that peform the alignment operations in
the Alignment tab of the tool bar.

The “Adjust Grid” command brings up a dialog box which allows you to enter
a grid size. By default the value is one, which is equivalent to “grid off.” A
value greater than one will cause all dragging and resizing actions to be
constrained to the grid size.

The “Resize Dialog” command brings up a dialog which lets you specify a
width and height for the interface window you are editing.

The “Text Serialization” command in the “Utility” menu should not be used.

Note that if you do not save your changes before quitting, Interface Builder
will not prompt you with a “Save Changes?” dialog box.


